Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Trainer Notes All days Routine Tasks

Technology Management Strategy at Student Workstations:

Red cups - Give each participant a red cup to place on or beside the computer. The red cup
will be used to indicate the need for help. Participants will be asked fo put the red cup up
on the computer when they need help. The frainer will use the red cup, saying cups up or
cups down, to indicate when participants have finished a process during the lesson.

Kiosk:

There is a kiosk, created in PowerPoint, for each day of the training. Have this playing as
the participants enter the training room. Here they will find the daily objectives,
software used, daily assignments including the daily diary topic and any information the
trainer wants them to have. Update before each training. Kiosks can be downloaded from
the trainer web site at http://www.i3forteachers.com/sslatraining

Music:
Have a music CD playing as participants enter the room and are participating in the morning
assignments.

E-Mail & "Sites of the Day”:

Trainers send email messages to the participants each day after Day 1. The suggested
messages can be found with the Trainer materials. You will be sending them an email that
has questions pertaining to the reading assignments and several internet "Sites of the
Day.” These are general reference sites for teachers. Spend a few minutes each morning
going over the sites to familiarize participants with them. Emails and "Sites of the Day”
can be found on the trainer CD can be downloaded from the trainer web site at
http://www.i3forteachers.com/sslatraining

Daily Diary:

Participants are asked to reflect in a daily diary. After day 1 this is completed as the
participants arrive. It is part of the daily assignments listed on the kiosk. Daily Diary
topics can be found with the Trainer materials. Each day participants will be asked to
group share their daily diary reflections. After group share the leader of the day will
report to the whole group what was discussed. This is a time for the trainer to
understand what issues the participants are facing both in the fraining session and in their
classrooms. The trainer will lead the discussions providing input on the “hot" topics.

Daily Diary topics can be found on the trainer CD can be downloaded from the trainer web
site at http://www.i3forteachers.com/sslatraining
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Trainer Notes All days Routine Tasks

Professional Readings -

Daily participants are required to read from the appendix of the notebook. Questions
regarding the readings are part of the email activity.

Day 1 - Appendix Page 1-7

Day 2 - Appendix Page 8-16

Day 3 - Appendix Page 17-24

Copyright © 2004 i3 Training Services Inc.



Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Trainer Notes Day 1  Set-up Checklist

Check the following website for any resources, templates, etc. you may need to
teach i3 training. http://www.i3forteachers.com/sslatraining

Check software: Microsoft Word, Internet Explorer or Netscape, Inspiration and
Virtual Globe.

Check the Internet links that will be used for the day to make sure they are active.

Test log-ins.

Update and start the Day 1 Kiosk on the Trainers workstation

Kiosk update should include dates of trainings, time of classes, lunch break, other
breaks, any other information that you want your participants to know.

Check the workstation desktops for the participant folder.

Check the video, Rainforest Rap and the sound.

Place post-it notes and pen at each workstation.

Place red cups at each work station - classroom management strategy or clips on
laptops..

Hang examples of work.

Hang the Grouping charts.

Group participants and hang names of group members under Grouping charts.

Create name tags and place on top of each computer.

Assemble Sign-in sheets.

Assemble notebooks and place next to workstations.

Set up a crate for group folders.

Check paper and ink in printers.

Load music €D and have playing as participants arrive.

Hang Writing Process signs.
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Trainer Notes Day 1 Agenda

> Tropical Trek

> Welcome, Housekeeping, Purpose of Training
> Rainforest Around the World

> Writing About Rainforests

> The Writing Process & Technology

> Daily Diary Writing

> Setting up E-Mail Accounts

> Scan Converters & Data Projectors

> Windows Basics

> Rain Forest Researchers (Supplemental)
> Closing

Copyright © 2004 i3 Training Services Inc.



Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Tropical Trek - Day 1 - page 1

Trainer Notes - Introductory Activity / Ice Breaker/Creating a Template

e Have participants remove page 1 - Day 1 from the Notebook

e Participants are asked o walk around the room greeting one another and asking for
others to initial their chart.

e This activity is more than an icebreaker activity. During the interaction with peers,
participants will

o gather information about each other

o gather background information on rainforests

o use an electronically generated chart template

Trainer: End of Activity Discussion

e How many signatures were gathered? Who got the most signatures? You can give a
prize to the person who got the most signatures.

e Use the information on trek to provide information for Housekeeping:

o Ask food questions. Comment on that and then tell them about break and lunch
plans.

o Who in the room drinks more than 3 cups of coffee a day? Tell them where the
restrooms are located.

o As you can see our theme for this training is Rainforests. During this training
you will be participating in curriculum activities that are based on the Rainforest
and at the same time you will be utilizing a variety of technologies. We will be
modeling and you will be participating in activities that can be replicated in the
classroom.

e We know that one of the points of this activity is to "meet and greet”. Now let's look
at page 1. What do you see? What is this? Responses you are looking for are:

o Water - this is all tied around a theme

o Looks like a table, bingo game, or math array

Nearly everything we do in the training has a practical application that ties to what

is done in a classroom. We have used a table format in Word to create this activity.

On Day 3 you will create a table. The activities in which you participate can be

connected to what you do in the classroom with students.

e Finish Housekeeping

o Kiosk will be on each morning. Check it, complete the activities.

o 6o over sign-in sheets, group charts, check-off sheet and participant folders.

o Markers and stickies: use to write down any questions that can be
immediately answered, post on board so that frainer can answer.

o Discuss working Notebook format. Point out the ID/Passwords record sheet
and the Bookmark record sheet.

o Add talking points on information you have added to the kiosk.
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Tropical Trek

Get to know your classmates. See if you can find someone who has done each of
the things listed below. Get them to initial your squares. Remember only one

person per square.

Good Luck!

Has been to Zoo
Atlanta this year.

Ever owned a
parrot.

Been to South
America.

Eaten a guava.

Eaten a mango.

Drinks more than 3
cups of coffee a

can name 3
products from the
rain forest.

Owns something
made of mahogany.

day.
Can name 3 animals Has cracked open a
that live in the Has rattan Has seen passion P
. . . coconut.
rainforest. furniture. frurt.

Owns an African

Got an orchid for
Easter.

Bought new tires in
the last month.

Has varnished
furniture in the last

violet. year-
Stepped in gum Planted a’fr'ee this Held a snake. Picked bananas.
lately. spring.

Owned a reptile.

Has a rubber plant.

Has a butterfly
collection.

Has talked to
students about the
rainforest.
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Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Shifts in the Teaching and Learning Process
Day 1 - page 2

Trainer Notes - Briefly discuss the following items:
e How technology happens today.
e How technology impacts student achievement.
e Why it is important to focus on how to use technology with what I teach daily.
e What is our goal here?

o It is not about what you know about the computer or how to use the
computer, but about how to use the technologies for instruction that directly
impacts student learning.

e Discuss the Shifts in the Teaching and Learning Process

o This training is a journey that requires us to rethink the way we teach in the
classroom. How can we integrate technologies? What difference will they
make in the teaching and learning process? When do I use the technologies
appropriately? Am I ready to change the way I am teaching?

e What is the i3 Inc. training concept:

o Based on research on what makes good professional development.

o Six years of successful implementation.

o Includes training on:

» State standards

» Use of technologies

» Classroom management

» Best practice teaching and learning strategies
e Whole group learning
e Teacher-guided instruction
e Small group
e Paired learning
e Peer-to-peer tutoring
e Individual activities

» Pedagogical concepts

o Designed to meet state standards; the ISTE Performance Standards and
allows you to meet the ISTE Standards for students - http://www.iste.org

o Designed fo focus on classroom lessons. Participants create and implement
technology-connected lessons.
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Shifts in the Teaching and Learning Process

Educational technology affords the opportunity for the following shifts to occur in the
teaching and learning process.

Shift from whole-group to small-group instruction.

e Shift from lecture and recitation to coaching.

e Shift from working with better students to working with weaker students.
e Shift toward more engaged students.

e Shift from assessment based on test performance to assessment based on
products, progress, and effort.

e Shift from a competitive to a cooperative social structure.

e Shift from all students learning the same things to different students
learning different things.

e Shift from the primacy of verbal thinking to the integration of visual and
verbal thinking.

Source:
Collins, A. (1991). The role of computer technology in restructuring schools. Phi Delta Kappa, 28-36.

Copyright © 2004 i3 Training Services Inc. inspiring, innovative, integration Day 1



Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Requirements - Day 1 - page 3

Trainer Notes: Training Requirements

Determine the requirements you want in place for participants.

We included basic requirements for classroom technologies. Participants need to
have a computer in their classroom to use with students prior to attending the
training.

Must attend all days of training. Any hours or days missed must be made up.
Create #(you decide) number of technology connected lesson plans that are to be
implemented and self-assessed in the classroom. Decide when participants are to
turn in these lessons to you. You could create a database of technology-connected
lessons that could be shared electronically.

Presentation by participants at the end of the training sharing what they have
accomplished.

Read and share professional readings as assigned.

Add requirements based on school district needs.
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Requirements??

Prerequisites:
Willingness to try new things and accept that change can be good.
Attendance:
Must attend all days of scheduled fraining.
Assignments:
e Implement and submit technology-connected lesson plans.
e Presentation of implemented lesson/s, student products, etc. due on Day 4.
This is a celebration of your success.

PRINT!
I SAID PRINTY
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Rainforests around the World
Day 1 - page 4

Trainer Notes - Lesson Format

Discuss with participants how this lesson is designed. This lesson format is used
throughout the four days of training. The format is set up to address the instruction for
the training participants and the lesson that would be used in a classroom with students.
We are modeling what is happening in a classroom while teachers are participating in the
training. This format is the one that they will use in designing their required lessons.

Notes for training participants:
o Essential question for teachers: What will they learn during this lesson?
e Teaching strategies modeled
e Technology strategies modeled

Notes on lesson format:
o Essential question - expected student learning outcomes
e Learning standards - Michigan standards covered in the lesson

Notes on lesson objective:

Go over the learning standards. Discuss how participants should always introduce lessons
with objectives or standards so students know what they will be learning and the expected
learning outcomes.

This lesson uses a multitude of technology resources with the primary objective to gather
knowledge about rainforests.
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Rainforests around the World

Teaching | Technology Instruction
Strategies | Strategies | Essential Questions for Teachers:
Modeled Modeled | Can I effectively use one computer as an instructional tool in my classroom?
How can a scan converter facilitate instruction? How do I use an electronic
atlas?

Essential Question:

What is a rainforest? Where are Rainforests located? How
might the ecosystem enhance and or dictate the culture? How
might the culture impact the ecosystem?

Learning Standards (State of Michigan):

Social Studies Standards

All students will conduct investigations by formulating a clear
statement of a question, gathering and organizing information
from a variety of sources, analyzing and interpreting information,
formulating and testing hypotheses, reporting results both orally
and in writing, and making use of appropriate technology.

All students will describe and compare characteristics of
ecosystems, states, regions, countries, major world regions, and
patterns and explain the processes that created them.

All students will describe, compare, and explain the locations and
characteristics of ecosystems, resources, human adaptation,
environmental impact, and the interrelationships among them.

English/Language Arts Standard

All students will read and comprehend general and technical
material. All students will demonstrate the ability to write clear
and grammatically correct sentences, paragraphs, and
compositions. All students will focus on meaning and
communication as they listen, speak, view, read, and write in
personal, social, occupational, and civic contexts.
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Rainforests around the World
Day 1 - page 5

Trainer Notes - Lesson Format continued

Notes on lesson format:
e Materials - resources needed to complete the lesson

e Technology Connections - The technology that the teacher and student will use to
complete the lesson.

e Procedures - Step-by-step procedures to complete the lesson.
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Computers in
the Classroom-
Gateways to
Communication
and Learning
http://www.te

chlearning.com
/db_area/arch

ives/WCE/arc
hives/norris2.
htm

Whole Group
Instruction

Pair/Share

Whole Group
Instruction

Whole Group
Instruction

VCR/Video

Electronic
Encyclopedia

Virtual Globe

Materials:

Teacher created PowerPoint, Computer with Internet Connection,
Virtual Globe or other electronic atlas software, thematic video,
student handouts.

Technology Connections:

Students will watch a video to gather background knowledge,
gather information from a electronic atlas and a Web site, view a
teacher-created PowerPoint presentation, use Inspiration to
organize collected data, and use word processing software to
participate in a synergized writing activity.

Procedures:

Large Group Activity:

Instructor will intfroduce the concept of how different
ecosystems might dictate or influence the culture of an area by
talking to students about their personal histories,
neighborhoods, religions, and family traditions.

Large Group Activity:

1. Students will view and listen o Rainforest Rap Video clip to
determine characteristics and locations of rainforests.

2. Students will view Encarta Encyclopedia and Virtual Globe to
locate continents, equator, Tropic of Cancer, Tropic of
Capricorn, and countries where rainforests can be found.

3. Instructor models use of basic word processing in Microsoft
Word as participants offer sentences, which synthesize all
group information in response to question, "Where in the
World are we?"

Individual Activity:

1. Students will create a legend on the July Precipitation data
collection sheet to include: equator, Tropic of Cancer, Tropic
of Capricorn, colors for rainfall measurements.

2. Students will shade and label the rainfall in South America,
Africa, and Indonesia

3. Students will create a legend on the July Temperature data
collection sheet to include: equator, Tropic of Cancer, Tropic
of Capricorn, colors for temperature measurements.

4. Students will shade and label the temperatures in South
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Rainforests around the World
Day 1 - page 6

NOTES

Copyright © 2004 i3 Training Services Inc.



Technology Tools in the Secondary Social Studies & Language Arts Classroom 6

Scan
Converter

Scan
Converter

PowerPoint

Internet-

Inspiration,

America, Africa and Indonesia.

Students will share information from mapping activity.
Students will use Encarta Encyclopedia and Virtual Globe to
locate at least three facts on Bali Islands, Indonesia. List
information on the Rain Forest map sheet.

Students will organize preliminary facts about rainforests and
specific facts about Indonesia on an Inspiration graphic
organizer. From that they will create an outline in Inspiration,
to use for a writing activity.

Large Group Activity:

1.

Introduce the 3-rainforest locations we will be investigating.
Instruct students on how to utilize the hyperlinks in the
PowerPoint so they can use them for self guided exploration
and research on the ecosystems and cultures.

Students will use fact-gathering sheet to collect specific
data during the Power Point presentation.

. Ask students to help you use that information to write a class

paragraph. Give one student a blow-up globe. Ask that
student to tell you a beginning sentence for the paragraph.
Type the sentence into a new document in Student Writing
Center. The first student passes the globe to someone else
who gives you the second sentence. Keep passing the globe
until you have enough sentences for your rough draft.

When you have finished the paragraph, explain that you are
going to begin the revision process. Ask students to help
identify any sentences that don't belong or are not in the
right order. Make changes upon students’ suggestions and
have them fo continue to pass the globe.

When all revisions have been made, explain that you are going
to start the editing stage. Ask students to help you identify
any misspelled words or mistakes in punctuation and
capitalization. Make sure that all students have received the
globe and have had a chance to participate in the writing
process by the end of this stage.

Now give each student a storyboard. Ask students to write
their own paragraph about what they have learned about
rainforests.

Assign each student a peer editor with whom they will
exchange papers. Give each editor a checklist to use as they
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Rainforests around the World
Day 1 - page 7

NOTES

Trainer Notes - Procedures
e Open the training Handbook and remove pages 8, 9, 10, 12. Close your book and put
it away.

Trainer Notes - Video - Really Wild Animals - Deep Sea Dive - Whole Group Learning
Materials Needed:
Rainforest Rap Video

e We are using a new piece of technology..a VCR and a video. Show the rainforest rap.

e Participants are to watch and listen. Discuss what they remember. Encourage
participation.

e Rewind video. Ask how many use videos in the classroom. For what purpose?
Traditionally we put in a video and show a 30-minute or longer program. We are
going to use this video differently. I will be using the remote to segment the video
so that you can gather background knowledge on rainforests.

e Pair and Share - Have each participant pair with another participant and share the
facts they have gathered adding facts to their lists on page 8.
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Technology Tools in the Secondary Social Studies & Language Arts Classroom 7

check their partner's papers for mistakes.

8. After editing, allow students to publish their writing using
Student Writing Center or Microsoft Word. Allow students
to go to the Rainforest Image Folder to pick an image for
their paragraph.

9. Students will change font, style, color, and alignment.

10. Students will use spell check.

11. Allow students to print their work and share it with a peer.

Assessment: Students will be assessed on their answers on the
Fact Gathering Sheet, completed maps and writing activity.
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Rainforests around the World
Day 1 - page 8 continued

Video Review
e Our objective was to gather background knowledge in a whole group setting. Use
the remote to segment videos for the exact information you need for a lesson.
When students watch TV it is usually for pleasure, for numbing, for escape. We
must use videos differently if we are to expect students to learn from them. We
segment, pause and dissect the information for the learning experience.

a Start with the Rainforest Rap and gather as many facts on the rainforest that you
can.
o Use the data collection sheet.
o Stop and star the video, talk about visual and auditory learning. (See notes)
Show video at least twice maybe 3 times. After you have talked about
auditory/visual learning have participants pair up and share the info they have
gathered (Pair Share)

o Bring up the Imagination Express Rainforest CD and play the animation of
Rainforests. Or, use the BrainPOP video on rainforests at www.brainpop.com
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Rainforest Rap
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Rainforests around the World
Day 1 - page 9

Trainer Notes: Virtual Globe - Whole Group Learning
Now that we have some facts and information about rainforests lets find out where
they might be located.
o Bring up the map on the website of where rainforests are located. Talk about the
three horizontal lines.
o Have students mark them on both their maps Page 9-10. What would help us
better understand this Map?
o Label the continents; on your rap sheet write the continents down where
rainforest are found. Can you identify any of the countries?

Bring up Encarta virtual globe or Encarta with Physical features unlabeled, talk about the
land masses and water.

o Change to physical features labeled, have students check their maps, now change
the map to climate and talk about the fact that in order for rainforests to exist
they need have avg temp and rainfall.

o Bring up the map legend. Based on these climates where would you most likely
find rainforests? South America, Central Africa, Indonesia.

o Change to the Political and use the pushpins to locate the three countries.

** Have students turn their computers on, or the monitors and start up virtual globe. Take
them through the same steps so that they now have pushpins in each of the three
countries we will be studying.

The questions to ask yourself- Am I doing this because it is neat or because it is
going to get me to my instructional goals?

e Keep emphasizing that this is the base we are forming today. That this is the
information that will be the foundation for other lessons.

e Discuss using Virtual Globe as a resource for teaching. What is the value of using a
piece of "cool” software for this activity? Discuss the importance of choosing the
most effective resource for a lesson.

e We have used the Virtual Globe in a whole group lesson to develop and teach
concepts with students.
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Defining & Locating Regions
Precipitation Map

Map Legend
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Rainforests around the World
Day 1 - page 10

NOTES
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Defining & Locating Regions
Temperature Map

\2
(S

Map Legend
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Rainforests around the World
Day 1 - page 11

NOTES

Trainer Notes: KWL with Inspiration - Whole Group

Materials Needed: Inspiration Note taking sheets 8 and 9.
Now that we have a good base of general knowledge about Rainforests we need to do some
organization of the info.

Whole group the Inspiration process like the one in the book. Ask someone to drive
the computer. Have the base organizer up and minimized so you can bring it up
quickly and use it. Do a whole group web on the info discovered so far.

Open the template "Rainforests”. Choose a “driver” someone in the class who will
operate the computer while you lead the instruction. Tell the "driver” fo make some
spelling errors.

Have participants call out what they learned about rainforests. Start with animal
information. Enter it into the web by using the Rapid Fire button in Inspiration.
Facts are scattered all over the page. To organize click on the Arrange button and
use the Top Down Tree and Lower Level Center.

Click on Zoom to show whole web.

Click on Outlining and change to Outline.

Check spelling.

Why did T have a student “driver*?

Participants will now create this same web completing the information for cultures,
location, plants,products and Other information while learning to use Inspiration.

Trainer Notes: KWL with Inspiration - Individual Hands-on
Materials Needed: Inspiration
Note taking sheets 10, 11, and 12

Step participants through the process of opening Inspiration. You are going to
create this graphic organizer and you will be adding additional information
throughout the training. You will also continue to learn to operate this piece of
software.

Go to the Start menu, choose programs, Inspiration 6, then click on Inspiration 6
Point out that the Main idea is highlighted. Type Rainforests
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Rainforests around the World
Day 1 - page 11 continued

e 6o to format, change size to 18

e Show how to click in and out of writing area

e Click on Rapid Fire

e Type- Location (enter) Type- Products (enter) Type- Animals (enter) Type- More
Information (enter)

e Click on Locations. Click on Rapid Fire. Enter location information.

e Do the same for the other areas

e Show how to Save. Do fogether. File, save, ask two questions - what am I going to
call it, and where am I going to put it? Save early and often. Give clear directions
on how to save. What to call it? Where to put it?

e Have participants:

Change the font, style, text

Insert graphics from the libraries

Use/text/line/fill color

Use of hand cursor to place the web in the center of the screen

Zooming in with the big and little mountains

Resizing and moving a symbol

Use Edit, Select, Symbols to select all symbols for changes

Demonstrate outline view

Add their name to the organizer by creating a detached item with the create

button on the foolbar.

See name in outline mode

Print graphic organizer. Follow these steps. All participants go to file, print.

STOP. See print window. Don't hit print until I tell you when. We are going

to print in order so that the student work is organized and collated.

Designate a class print manager who will go to the printer and get the collated

graphic organizers. All students will not have to stand and wait on the

printer.

O O O O 0O O O O O
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Culturess
Feople

What do we know

about Rainforests? \ i

-

Animals

Layvers

Froducts

What do we know
about Rainforests?

Y

Anirmals Layers Cultures/ Plants Products
{_I People
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Rainforests around the World
Day 1 - page 12
Native Rainforest People

Trainer Notes: Native Rainforest People PowerPoint Activity

Explain to participants that we will be studying three different countries where rainforest
exists. We will be gathering information over the three days to answer many questions. We
will be looking at the countries economic, political, environmental and cultural issues. We
will also be looking at how the rainforest that exist in those countries impact these things
and the indigenous people. The impact they have on each other.

Lets take a look at the three tribes we will be investigating over the next three days.
Bring up the Tribe PowerPoint and have students take out their tribe data collection sheet.
Show the interactive Power Point whole group and have students gather data.

Who are the Tribal People of the Rainforest?

Explain why this PP was built this way. Could be used as a whole group, small group or
independently. Explain that students must close out of the browser so that the next
window will pop up.

Have students bring up the PowerPoint and gather a few facts about each tribe. Location

Have students bring up their web and add new information about their cultures.
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Native Rainforest People Note Sheeb

Yernoweimi

Belke

Wenbduyseli
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Writing about Rainforests
Day 1 - page 13

Trainer Notes - Writing Activity

Participants will use the background knowledge gathered on water and bodies of water
during the Water, Water Everywhere, but Where? lessons to produce a writing activity.
Students will participate in the writing process using an electronic word processing
program.

Materials Needed:

e Microsoft Word or writing software of choice

e Water, Water Everywhere graphic organizer

e Page 25, 3-5 Writing Storyboard

e Page 26, Peer Editing Checklist

e Page 27, Student Self-Assessment

e Page 28, Assessment

e Pages 29 - 34, Information on the Writing Process

Trainer Notes - Synergized Writing Activity - Drafting At this point all participants
have had an opportunity to discover new information about rainforests. As in the
classroom setting they need to have an opportunity to talk about what they have learned.
This will provide the teacher with an opportunity to make sure all students understand the
topic - rainforests. Participants will be involved in a synergized writing activity, working in
a whole group setting drafting a paragraph on the topic. This writing activity is designed
to receive input from everyone on the topic and to create the whole (the paragraph) in an
unthreatening environment. Trainer uses this time to teach the basics of a word
processing program. Model the use of the word processor on a large screen, using 24-point
size, to create a page title "Rainforests” Type information volunteered about rainforests
by the students into the word processor. Disregard grammatical errors at this time.

Trainer Notes - Revising activity The revising stage focuses on meaning. Reading aloud is
beneficial way for the author to examine his own writing. Ask participants to orally read
2-3 lines of the text typed during the drafting stage. Most will quickly realize that the
flow of ideas is irregular and English grammar conventions are needed to refine the
meaning of the text.

Demonstrate the use of the following skills: highlight, copy, paste, insert cursor, highlight and replace,
add capital letters, spellchecker, thesaurus, etc.
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Writing Activity

Teaching | Technology Instruction
Strategies | Strategies | Essential Questions for Teachers: How do I use the outline feature of
Modeled Modeled | Inspiration? How do I collect and use graphics from the Internet? What are
the steps in the Writing Process?
Essential Question:
ABC's of the . .
Writing What have I learned about Rainforests? Can I write a paragraph
Process stating what I've learned?
http://www.
angelfire.co . . L .
o /wi/writin Learning Standards (State of Michigan):
gprocess/ English/Language Arts Standards

All students will read and comprehend general and technical
material. All students will demonstrate the ability to write clear
and grammatically correct sentences, paragraphs, and
compositions. All students will focus on meaning and
communication as they listen, speak, view, read, and write in
personal, social, occupational, and civic contexts.

All students will define and investigate important issues and
problems using a variety of resources, including technology, to
explore and create texts.

All students will demonstrate, analyze, and reflect upon the skills
and processes used o communicate through listening, speaking,
viewing, reading, and writing.

Materials:
Student Writing Center or Microsoft Word, Inspiration,
Internet, blow-up globe, world map

Technology Connections:
Students will use the facts they gathered in their Inspiration
Web to create an outline. They will use that outline to write
using their draft storyboard and then word process in Student
Writing Center or Microsoft Word. Students will collect a
graphic from the Internet to use in their project.
Procedures:

1. Review the rainforest information that students learned in

the previous lesson.
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Writing about Rainforests
Day 1 - page 14

NOTES

Techie Talk - Word Processing Fundamentals -
Word processing skills are taught throughout the five days of the training. The listed
skills are skills the trainer will want fo teach but not necessarily all at one time. Teach
these skills when the time is appropriate within the framework of a lesson.
e How to Use Menus
e How to Open Toolbars- Standard, Formatting, Picture and Drawing Toolbars
e Hiding, Display Location, and Moving Toolbars
e Openinga File
e Editing Text
e Inserting, Replacing, and Deleting Text
e Highlighting Text
o Double-click a word
o Highlight a line click in front of line or Triple Click
o Move cursor in front of desired area to highlight. Hold down the Shift Key.
Move and place the cursor at the end of area to be highlighted.
e Cutting, Copying and Pasting Text can introduce shortcut keys
e Changing Font Type, Size, Color, Style, Alignment
e Using the Undo Feature
e Adding Clipart to the Document
o Insert Clip Art
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Whole
Group
Instruction

Whole
Group
Synergized
Writing
Activity

Individual
Work

Partner
Activity

Individual
Work

Inspiration
Scan
Converter

Student
Writing
Center or MS
Word

Scan
Converter

2.

w

Show students the class Inspiration Web that was created
and review the information written in each field.

Using Inspiration fo create an outline.

Ask students to help you use that information to write a
class paragraph. Give one student a blow-up globe. Ask
that student to tell you a beginning sentence for the
paragraph. Type the sentence into a new document in
Student Writing Center. The first student passes the
globe to someone else who gives you the second sentence.
Keep passing the globe until you have enough sentences for
your rough draft.

When you have finished the paragraph, explain that you
are going to begin the revision process. Ask students to
help identify any sentences that don't belong or are not in
the right order. Make changes upon students’ suggestions
and have them to continue to pass the globe.

When all revisions have been made, explain that you are
going to start the editing stage. Ask students to help you
identify any misspelled words or mistakes in
punctuation/capitalization. Make sure that all students
have received the globe and have had a chance to
participate in the writing process by the end of this stage.
Now give each student a storyboard. Ask students to
write their own paragraph about what they have learned
about rainforests.

Assign each student a peer editor with whom they will
exchange papers. Give each editor a checklist to use as
they check their partner's papers for mistakes.

After editing, allow students to publish their writing using
Student Writing Center. Show them how to add their
saved Internet graphic. Allow students to print their work
and share it with a peer.

Assessment: Students will be assessed on their completed
sentences/paragraphs with a self-evaluation and a rubric.
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Writing about Rainforests- Storyboard
Day 1 - page 15

NOTES
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Writing Storyboard

Name Date

Peer Editor Graphic

Graphic:
File Name

Location

Write a paragraph about rainforests.
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Writing about Rainforests- Checklist
Day 1 - page 16

NOTES

Trainer Notes - A checklist for students to use to self-edit their work. Editing
Checklists will assist students in identifying errors.

Students should always know prior to producing a product what their expected outcome is
or what the teacher will assess. Teachers may use this checklist at the beginning of the
assignment to make students aware of expected outcomes.
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Peer Editing Checklist

Author's Name

Editor's Name

Put a check in each box.
o Proper nouns are capitalized.
o The first word of each sentence is capitalized.
o Each sentence begins in a different way.
o Each sentence is complete (has a noun and a verb).
o There is a punctuation mark at the end of each sentence.
o Commas are used to separate items in a list.

o Apostrophes are used in contractions
and possessives.

o Information clearly relates to the main
topic. It includes several supporting
details and/or examples.
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Writing about Rainforests- Student Assessment
Day 1 - page 17

NOTES

Trainer Notes - A checklist for students to use with a peer. Share paragraphs or
sentences with a partner and peer edit using this checklist. Peer editing is beneficial and
promotes collaboration among students. Editing Checklists will assist in identifying errors.

Students should always know prior to producing a product what their expected outcome is

or what the teacher will assess. Teachers may use this checklist at the beginning of the
assignment to make students aware of expected outcomes.
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Student Self-Assessment
Name: Date:

Peer Editor: Project:

Use this checklist to carefully check your paragraph. Don't forget to double-check your
work!

a My paragraph clearly relates to the main topic. It includes several supporting details
and/or examples.

o I read the paragraph for meaning.

0 I checked the paragraph for complete sentences.
o I used correct principles of grammar.

o I used the spell-check tool on the computer.

o I double-checked for correct spelling.

o All sentences start with a capital letter.

o Proper nouns are capitalized.

o The title has capital letters where needed.

o Each sentence ends with proper punctuation.

o Commas and quotation marks are used correctly.

o I followed the procedures of the writing process: prewriting, drafting, revising,
editing, and publishing.

o I reread the paragraph carefully for all errors.

o I used 2 graphics in my published paper.
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Writing about Rainforests- Assessment
Day 1 - page 18

NOTES

Trainer Notes - A checklist for teachers to use when assessing student work.
Students should always know prior to producing a product what their expected outcome is

or what the teacher will assess. Teachers may use this checklist at the beginning of the
assignment to make students aware of expected outcomes.
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Assessment

Name: Date:

o The paragraph clearly relates to the main topic. It includes several supporting
details and/or examples.

o The paragraph was edited for correct use of capitalization, punctuation, and
spelling.

o Correct principles of grammar were followed.
o The writing process was followed: prewriting, drafting, revising, editing, and

publishing.

Teacher comments:

Student comments:
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The Writing Process & Technology
Day 1 - page 19

NOTES

Trainer Notes - An overview of the writing process. As you are teaching the Watery
Writing lesson you will cover the information on these pages.

Prewriting - Inspiration activity

Drafting - Synergized writing / using storyboards or the word processor

Revising - Revise draft either with pencil or paper or with word processor. If completing
this electronically teach the participants how to highlight text, copy, paste, insert cursor,
highlight and replace, add capital letters, spellchecker, thesaurus, etc.

Editing - Peer editing and self editing checklists

Publishing - Use a word processing program to publish the sentences or paragraph. At the
same time teach the basic skills of a word processing program.
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Related
Resources

The Writing Process

Writing as a Process
From the time children learn how to write their first word, they begin to
build the skills needed to begin the writing process. These stages
include:

T Prewriting K Drafting K Revising M Editing & Publishing

It is not necessary for students to move through each of these stages in
order every time they write. Each stage can be taught and reinforced in
combination with other lessons and students should be free to write and
revise and revise again if necessary.

Students usually start their experience by writing personal narratives.
They can continue this type of writing as they get older by recording
experiences in daily journals. Students also enjoy writing imaginative
stories and responses to literature as they reflect on something they
have heard or read. They can also write content area pieces, which
report information that they have learned through research. Expository
writing is an essay to explain or persuade the audience. They can use all
of these writing styles in a variety of ways including letters, poems,
essays, editorials, reviews, travel brochures, postcards, character
analyses, and more.

Students need time each day to practice writing skills. They can write in
daily journals that can be used to communicate feelings and emotions
about things that are happening in their life. Students need a time each
day to write for various reasons. Writing should be integrated
throughout the curriculum as they write about science experiments,
create math stories, and explain concepts that they have learned in
Social Studies.

Technology can serve as a catalyst that students can use to do their
writing. Typing and editing stories on the computer can often take the
monotony out of a process that some students may find uninteresting.
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The Writing Process & Technology
Day 1 - page 20

NOTES
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See more story
sparks at
http://www.ange
Ifire.com/wi/wri
tingprocess/pre

writing.html.

For examples of
some of these
organizers, see
http://www3.sk.
sympatico.ca/fis

s/pre-writ.htm.

If Inspiration is
not available at
your school, you
can use one of
the on-line web
generators like
the one at
http://www.teac
h-
nology.com/web
tools/graphic

org/

Prewriting
All writing begins with some form of prewriting. In this stage, students
choose a subject and begin to organize their thoughts before they start
to write. If students are not assigned a specific topic about which to
write, they need to decide on one. You can use the following motivators
to spark student’s creativity:

o A group experience
An individual experience
A piece of literature
An unexpected happening
A common feeling
A question
A memory
A discussion

0O 000 00D

After students decide what to write, they need to organize their
thoughts using some sort of organizer. Students can use word charts,
story maps, webs, brainstorming individually or in groups, the class word
wall, a storyboard, note taking, outlining, or group discussions. As
students are working, they need to keep these questions in mind:

o Who is my audience?
What other ideas go with this idea?
Which ideas should be grouped together?
Where does each idea fit into the whole picture?
What do these ideas or phrases have in common?
In what order should these ideas appear?

| R R R W

Students can use technology in this stage of the writing process to help
them organize their thoughts in the form of a graphic organizer.
Inspiration software is an excellent source for outlining and webbing.

Drafting

Once students have organized their thoughts, they are ready to begin
writing. As students move from the prewriting fo drafting stage, they
need to keep the following points in mind:

o You do not have to include all points from your prewriting in
your draft. Make sure that you pick your best thoughts and
that all the ideas relate directly to your topic.

o Keep writing! Once you start writing, don't stop to correct
spelling and mistakes in grammar. Just keep writing. You
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The Writing Process & Technology
Day 1 - page 21

NOTES
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For more
Drafting
suggestions, see
http://www3.sk.
sympatico.ca/fis
s/first.htm

Several methods
that students
can use to
complete the
revision process
are found at
http://www.ange
Ifire.com/wi/wri
tingprocess/revi

sing.html

can correct errors later.

o Don't worry about the length of what you're writing. When
you feel that you have explained all of the ideas in your
writing, you are ready to go to the next stage.

o Reread what you have written to make sure there is enough
content before going on to the next stage. If you haven't
explained your topic fully, go back to your prewriting for
more ideas and details.

o Make sure that you use illustrations and details that will
catch the reader’s attention.

Poor writers can be paired with a peer tutor for extra help during the
drafting process for extra support. When students are working on their
draft, the teacher should be available to conference with them.

Technology can be used to assist in this stage, but it may be easier for
students to write their draft on paper before entering it in a word
processor. This frees them to concentrate on what they are writing
instead of worrying about the formatting and typing.

Revising
Revising is not the same thing as editing. When you edit, you check for
errors in grammar and spelling. When you revise, you look at the meaning
and the way that your ideas are presented. In the revision stage,
students need to make changes, additions, and deletions. It is important
to note that revision is not for editing conventions of spelling and
grammar. When it is time for students to revise their work, the
following checklist can be used:

o Can you read it aloud without stumbling over words?
Do all of your sentences relate to the topic?
Does the sequence of events make sense?
Are descriptive words used to describe characters or events?
Do you have a catchy introduction and conclusion?
Are you using the same words over and over again?
Are all of your sentences complete?

0O 00 D0 O O

Students often need help completing this stage of writing. Conferencing
can give students the feedback that they need to make changes and
revisions. Students may conference with another student or the
teacher. Younger writers should begin their revision process with a
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The Writing Process & Technology
Day 1 - page 22

NOTES
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You can create
your own editing
checklist at
http://www.4tea
chers.org/projec
tbased/checklist
.shtml, or use
the one provided
at
http://206.218.1
28.2/laintech/pe
er.htm.

Proofreading
Chart-
http://www.ange
Ifire.com/ks/tea
chme/editingcha
rt.html.

For more tips on
editing, see

http://www.ange
Ifire.com/wi/wri
tingprocess/edit

ing.html.

teacher conference, while more experienced writers can use peer
conferencing. Once students are old enough to conference with peers,
you need to teach them rules and procedures. Peer conferences can also
be modeled for students to show them how to interact effectively with
their peers and give constructive criticism. Initial peer conferences may
be centered on a checklist that each partner completes to evaluate the
writing.

Not all writing needs to go through the revision process. Students may
abandon a piece of writing because of poor choice of topic or lack of
interest. Just monitor students' progress to make sure that some of
their writing does go through all five stages.

Editing

The editing process focuses on making changes to grammar and spelling
conventions. If students are beginning writers, they need to focus on one
or two areas to edit such as capital letters or the use of punctuation.
More experienced students can focus on more areas. Proficient writers
can conference with other students and provide proofreading support
for each other.

Some tips for successful editing:

o Encourage peer editing for older students, which promotes
collaboration among peers.

o Use a student-editing checklist to aid students in looking for
errors.

o Teach students proofreading marks and display a chart in your
room for quick and easy access.

o Teach students how to use the spell checker and thesaurus that
are built into the word processor.

o Some word processing programs are capable of text-to-speech,
which gives students the chance to hear their writing read back to
them. This will help them see if their sentences "sound right".

o Younger students should refer to classroom word walls when
checking for spelling errors.

Publishing
Once students have invested their time and energy into going through
each step of the process, they enjoy publishing their work and seeing
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The Writing Process & Technology
Day 1 - page 23

NOTES
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Places for
students to
publish on-line:
http://www.liswa
.wa.qgov.au/funho
use/kidswrit.ht
m:
http://www.kida
uthors.com/;
http://www.veec
eet.com/

Locate e-pals on
http://www.keyp
als.com/ or
http://www.epal
s.com/.

how other people respond to their writing. Not everything that starts
with prewriting needs to make it to the publishing stage.

There are many ways for students to publish their writing. Listed below
are just a few:

o Ask students to record their writing onto an audiotape or
videotape. This is an excellent addition to a child's portfolio and
can show growth in reading and writing throughout the year.

o Make a book of students’ writing. Allow students to create a cover
and bind the book with a ring binder.

a Publish student writing in a school or class newspaper.

o Feature stories on a bulletin board and allow students to visit the
board to read peer’s writing.

o Create a multimedia presentation with illustrations using KidPix,
Power Point, or Hyperstudio.

o Type a final copy onto a word processor and jazz it up with
borders, clip art and special fonts.

Allow students to post their writing on-line.
Allow students to work with a group to dramatize a story that
they have written.

o Have students send their completed writing over e-mail to a
parent, e-pal, friend, or teacher.

Copyright © 2004 i3 Training Services Inc. inspiring, innovative, integration Day 1




Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Daily Diary - Day 1 - page 24

Trainer Notes: Activity that assess participant's thoughts and attitudes about
curriculum and technology integration. This activity is completed daily with a new question
for reflection.

Materials: Daily Diary question on Kiosk, Word Processing software

Writing Topic for Day 1 Diary
e What are my reasons for being here?
e What do you hope to gain from this experience?
e How do you envision your classroom changing with the use of technology?

Small Group / Whole Group Sharing of Daily Diary
e Move teams to small groups to discuss the diary reflection.
e Small groups share whole group responses to the diary reflection.
e Participants should print 2 copies of the daily diary. One copy is submitted to the
trainer and one is placed in their folder.
e Use the student check sheet to check when assignment is complete.

Trainer Notes:
e Daily Diary whole group sharing is an excellent time for the trainer to address
concerns of the participants. Be prepared to listen carefully and respond positively
when necessary. Don't let this turn into a gripe session.

Techie Notes:

e Working with documents and templates

o Open a document from a previously created file or folder

Create a document tfemplate
Opening a template - directly clicking the template icon
Revising a femplate - opening as a Word document
Differences between documents and templates
Saving documents as templates
Understand difference between document icon and template icon

O O O O O O
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Daily Diary

Name:
Date:

Everyday you will be instructed to complete a "Daily Diary" entry. You will
find the diary topic on the electronic bulletin board every morning. After
you have written in and saved your diary, you will need to print 2 copies, one
for your folder and one for your book.

Today's "Daily Diary” is

What are my reasons for being here? What do you hope to gain from
this experience? How do you envision your classroom changing with the
use of technology?
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Setting up a Eudora E-mail Account - Day 1 - page 25

Trainer Notes - Assist participants in setting up an e-mail account. Refer to the step-by-
step instructions to set up a Eudora account that are located with the Software helpers
for Day 1.

This email activity should be adapted for each trainer based on the email system that you
use.

Email is used daily with class participants. Each morning, participants check their email for
a message from the trainer. They will need to answer a question that relates to the
readings from homework and they will need to check the site of the day.
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Setting up a Eudora E-mail Account

Getting Started:

> Open up your Internet browser.
Click in the Location Box to highlight the URL.
Type: www.eudoramail.com
Press Enter on the keyboard.
Click on Sign-Up for your own free personalized E-
mail!
This will take you to Eudora Web Mail Terms of Use.
After reading (or not) the Terms of Use, click on "I
Accept”.

Y V V VY

Y VY

Setting Up an E-Mail Account:

> Click in the box by User Name to place the cursor.
Type your first initial and last name. (example: tsmith)
Press the Tab key to move to the next field.
Choose a password and type it in the Choose a Password box.
Press tab to get to the next field.
Type in the password again in this box.
Choose your time zone from the pull down menu.
Choose a password hint from the next pull down menu.
Click in the box below and type the answer to the question.
Press Tab.
Enter the necessary information in step 2.
All fields with a red dot are required fields and must be answered.
After completing all required fields, click on Register.

VVVVVYVVVVVYVYVYYVY

Completing the E-Mail Setup Procedure:
> Your assigned E-mail address will appear on the screen.
> Type in your password and hit Enter.
> This will take you to the Eudora Web-mail screen.
> You will now be at the In-Box where you will receive your mail.

Receiving and Sending E-Mail:
> If you have new mail, it will be listed in the In-Box.
> Click on the highlighted blue text to open your e-mail.
> To send an e-mail, click on the New Message button at the top of your screen.
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Setting up a Eudora E-mail Account - Day 1 - page 26

Trainer Notes - Continuation of steps in setting up a Eudora E-mail account.
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>
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Type in the Address of the person to whom you will send the message and
press the Tab key.

Type in a Subject for the e-mail. Example: "Technology Training”

Click in the message box to place the cursor and start typing.

Do a Spell Check with the button at the bottom of the screen (scroll down).
After you have completed your e-mail message, click on Send.

You will receive a confirmation message.

Click on Inbox mailbox to return to the main screen.

CC: Stands for Carbon Copy- if you wish to send e-mail to several different
people, list them in the CC section. The other recipients will see a list of the
people who received the message.

BCC: Stands for Blind Carbon Copy- If you wish to send e-mail to several
different people, but prefer that they do not know who else received the e-mail,
list them in the BCC section. The recipients will not see a list of the other people
who received the message.

Attachments: You can send a file along with your e-mail message. Simply click on
Attach File in your new e-mail message. Click Browse to locate the file and then
click attach.

Replying to a Message: If you would like to reply to a message sent to you, click on the
reply button at the top and type your message. A reply goes back to the sender.

Forwarding a Message: If you would like to forward a message to someone else, click
the forward button at the top. Forwarding a message just sends that same message
that you received to a different person.

Accessing Eudora Mail after registration:
> Type in www.eudoramail.com in the location box of your Internet browser.
» In the Registered Users box, under username, type your e-mail name.

(example: tsmith)

> Type in your password. Press the Enter key.
> You will be taken to the main screen where you can send and receive e-mail.
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Classroom E-mail Activities - Day 1 - page 27

Trainer Notes - Suggestions for using email in the classroom.
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Classroom E-Mail Activities

E-mail has opened up a whole new world of communication that links adults and children
internationally. Because e-mail has become such an « 7

integral part of communication, it is important that

classroom:

students be given the opportunity to share ideas and
thoughts with their neighbors around the world. Here _
s x>
O
ZIN
=(Q
e

are some suggestions for using e-mail in your

o Find an e-pal from another state or country and
exchange information about cultural
differences. Locate e-pals on
http://www.keypals.com/ or
http://www.epals.com/.

o Send weekly e-mail messages to all students that include your weekly schedule,
reminders, homework assignments, and special project information.

o Allow students o e-mail writing projects to each other for peer editing. The
editor can make changes in red type and return the document to the author.

o Students can share writing, thoughts, or technology projects with parents and
guardians by attaching them to an e-mail message.

o E-mail experts to ask questions students formulate about content area subjects
and units of study.

o Participate in on-line collaborative projects with other schools.

o Communicate with congressional leaders in Washington at
http://www.mrsmith.com/index2.html.

o Ask students o write fan mail to their favorite athlete or sports feam. You can
locate e-mail addresses for most sports teams and athletes on their homepages.
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Password Chart - day 1 - page 28

Trainers Notes - Participants are provided with this chart to keep-up with their
passwords. On day 1 training they will use this to keep track of their e-mail password
information.
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Password Chart

Account/Service

Location/URL

User Name

Password
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Software Helper Creating a Password Chart in MS Word
Day 1 - page 29

Trainers Notes - Participants are provided with this chart to keep-up with their
passwords. On day 1 training they will use this to keep track of their e-mail password
information.
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Software Helper
Creating a Password Chart in MS Word

The goal of this assignment is to create a chart for passwords using Microsoft Word. It is a good idea to
keep a record of passwords for any Internet account or service for which you register.

Steps to Create a Password Chart

1. Start the program Word.

2. Type in the heading “Password Chart."

3. Return twice.

4, Select the "Table" button from the task bar at the top of the screen.
5. Select "Insert Table."

6. Type in the number "3" by the Number of Columns.

7. Type in the number "15" by the Number of Rows.

8. Click the Auto Format Button.

9. Scroll down the Format column and click on the Grid One format.

10. Click Okay.

11. Verify that you have entered 3 and 15 and then click Okay again.

12. Click inside the top box of the first column. Type in the word "Account.”

13. Click inside the top box of the second column. Type in the word "User Name."

14. Click inside the top box of the third column. Type in the word "Password.”

15. Highlight the top row. Choose the Center format button on the task bar at the top of the screen.

16. Highlight the entire chart. Choose Format from the task bar at the top of the screen. Select
"Paragraph” and then select Line spacing. Select "I.5 lines." Enter.

17. Highlight "Password Chart.” Choose the Center alignment button from the task bar at the top of
the screen.
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Whole Group Learning with your PC

The Scan Converter
The easiest and cheapest way to accomplish whole group learning in your classroom with
a PC is by hooking up a scan converter. Scan converters are small devices that translate
the scan rate so the image on your computer screen can be seen on your TV. Now this
may sound simple, and it is, but the final quality depends on several factors. If you have
a new(er) TV and new(er) PC you should be in pretty good shape. Older TV's/PC's will
require a bit more work and the quality will be lower.

It is impossible to address ——
the myriad f’f pos;uble o | |
set-up configurations, so [
below you will find drawing A

, - —
of a basic set-up. Do your Back of F (Coaxial
best to follow these or PoormAC | o
consult the Web ven o

resources or your
technology professional in 5.~
your school or district. Outlet

RF (Coaxial-Cut to TV)
| —

VCR or
RF Modulator

—
1] //m
Sean (Video
Web ResourceS: Corverter DRCP. RCA Cable In)
10 Questions to ask : (video)

before buying a scan converter. http://www.vgav.com.au/convertors.htm

WEA In GA Cut

The Data Projector
This piece of hardware is quickly becoming the choice of educators for whole group
instruction in their classroom. The data projector is the equivalent of the movie
projector except instead of film being projected on the wall it projects what's on your
computer. These use to be so expensive that districts were lucky to have just one.
Recently manufactures have broken the $1000 floor on some models. Now it is not
uncommon to see new schools being built with these built-in to all classrooms. Even
though these can be purchased for under $1000 plan to spend about $1200-$1600 for
one of these for your classroom.

Web Resources:
http://www.becta.org.uk/teaching/pedagoqgy/technologies/projectors.html
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Software Helper

Windows Basics

The first screen that you see after starting your computer is called the Desktop. It is
where you do all of your work. There are certain items on your desktop that are there
to facilitate your work. These items can be customized to meet your own needs.

Items on the Desktop:

o My Computer- This icon enables you to have access to your hard, floppy, and CD
drives. You can also access your printers and the control panel.

o Network Neighborhood- Provides access to shared resources, such as printers and
networked computers.

o Recycle Bin- A temporary holding bin for files that you want to delete. Files placed
in the recycle bin can still be recovered until they are permanently deleted.

o Start Button- Provides access to the Start Menu. From the start menu, you can
access programs, documents, settings, help, and search options.

o Taskbar- This is the horizontal bar located at the bottom of your Desktop. All of
your open applications are shown on the taskbar and it enables you to move easily
between applications. The taskbar also displays the clock, the Start button, and may
house some shortcuts to programs.

Turning the Computer On and Off

To turn the computer on, check to see how the computer is plugged into the electrical
outlet. If the CPU, monitor, speakers, and printer are all plugged into a power strip,
simply turn on the power strip. If each part is plugged into a different outlet, turn on
the monitor first, then the CPU and finally the speakers and the printer.

To turn the computer off:
Close all programs, windows, and folders
Click on Start, and then Shut Down
Click on Yes.
Wait until the computer gives you the message that it is safe to turn of f the
computer.
Then either turn of f the power strip, or unplug the parts in this order: monitor,
CPU, speakers, printer.

Executing a Program
» Click on Start and drag the arrow to Programs.
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> Draw the pointer o the folder where the program resides and to the name of

>

the program.
Click to start the program.

Installing a Program
Most CDs will automatically open up in the Install Mode. You will simply follow the
on-screen instructions. If it does not, follow these steps:

YV VYV V VY

Y

Click on Start.

Drag the pointer to Settings, then click on Control Panel.
Double-click on Add/Remove Programs.

Click on Install.

Insert the CD or Disk into the drive.

Click on Next.

Follow the on-screen directions.

To Create a Folder on the Desktop:

Y

YV V V V

Right click anywhere on the blank desktop.

Click on New and then on Folder-.

Type in the name for the folder. (Example: name it "Applications”)
Press Enter

A folder entitled "Applications” should appear on the desktop.

To Create a Shortcut to a Program:
A quick and easy way to access programs is by making a shortcut on the desktop or in
your applications folder.

>

YV V V V

YV V V VYV

Double click on the Applications folder to open it.

Click on File, then New.

Click on Shortcut.

Click on Browse (you may need to change the drive to "C")

Find the program for which you want to make a shortcut (for example KidPix
Studio)

Look for the file name that has .exe at the end (Picker.exe)

Click on Picker.exe and then Open.

Click on Next and type a name for the shortcut. (KidPix Studio)

Click on Finish.

Find your new shortcut and test it out by double clicking on it to open the
program. Close the program by clicking on File and Quit.

To Format a Disk:
Most new blank disks will not need to be formatted. In the case that it does:

>

Double-click on My Computer.
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To Co

VVVVYVVE VYVYYYVYY

Y V V

Insert a floppy disk into the "A" drive.

Right click on the "A" drive icon.

Click on Format, under Format Type, click on Full.

Click on Start.

Click on Close.

Close the My Computer window.

a Disk:

Double-click on My Computer.

Insert the disk you want to copy into the "A" drive.

Right click on the "A" drive.

Click on Copy Disk and then Start.

When the message "Insert the Destination Disk”, put the blank disk to want to
copy to into the "A" drive.

Click on OK.

Click on Close when you get the message, "Copy Completed Successfully.”
Close the My Computer window.

To Create a System (Start Up) Disk:

>

YV VYV VY VYV

Double-click on My Computer, then on Control Panel.
Double click on Add/Remove Programs.

Click on the Start Up Disk tab.

Click on Create Disk.

Insert a disk into the A drive.

Click on OK, then OK again.

Click on the X in the title bar to close the Control Panel
Close the My Computer window.

To Rename a Folder or File:

>

>
>
>
>
>
>

Double-click on My Computer.

Double click on the drive that contains the folder or file to be renamed.
Click on the file you want to rename and then click again (softly).

This will highlight the old name and a cursor will appear.

Type in a hew name.

Press Enter.

Close the My Computer window.

Deleting a File or Folder

>
>
>

Double click on My Computer and the drive in which the folder is located.
Click once on the item you wish to delete and highlight it.
Press Delete on the Keyboard.
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> Tt will go to the Recycle Bin, you can retfrieve it until you permanently delete
it.

> To retrieve the item, double click on the Recycle Bin, and click on the folder
you wish to restore. Click on File, and then Restore. It will return to its
original location.

Moving a Window
» Inan open window, click on the Title Bar and drag the window to the desired
location.

Resizing a Window
> Put the pointer on the lower right corner of the window ( you will see a
diagonal arrow). Click and drag to make the window smaller or larger.

Copying and Moving Files
> Double click on My Computer and then on the drive where the file is located.
Double click on the drive where the file is to be moved or copied.
Move the open windows so you can see both of them clearly.
Find the file you want to copy and click on it.
If you are copying a file, click and drag the file to the appropriate drive. You
will now be able to access the file in both places.
If you are moving a file, hold down the Shift key as you drag and drop the file.

YV V V V

Y

Playing an Audio CD

Open the CD ROM drive by pressing the button.

Insert your CD.

Press the button again to close the door.

The CD should begin playing automatically.

The CD player will be shown on the taskbar.

Click on the CD player to open the window.

Place the arrow on the various buttons in the CD player to see the different

options.

The "Stop"” button is the black square, the "Play” button is the black triangle.

Click on the "Minimize" button (-) to place the CD Player back on the Taskbar.

> Click on the "Close"” button (X) to exit the CD Player. (Be sure to stop the CD
before you exit.)

VYV VYV VY VYV

YV VY

Volume and Sound Controls
There are two places to adjust the volume:
Check to make sure that the speakers are turned on and plugged in.
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> Click on the speaker icon in the lower right hand corner of the Taskbar.
> Move the lever up or down to adjust the volume accordingly.

> Click on Start, drag to Programs, Accessories, Multimedia, Volume Control,

and click. Adjust the volume in the same way.

Changing the Desktop Wallpaper (Background):

>

Y V V VY

>

Right click anywhere on the blank desktop.

Click on Properties.

Click on the Background tab if it does not come up automatically.

Under Display, click on Tile.

Under Wallpaper, click on the various patterns you can use on your desktop.
Select one that you like and click on it.

Click on Apply and then OK.

Changing the Screen Saver:

>

YV VYV VY VYV

>

Right click anywhere on the blank desktop.

Click on Properties.

Click on the Screen Saver tab.

Click on the down arrow to see a list.

Click on the various screen savers, find one that you like and select it.

Click on Preview.

Click on the screen to return to the Properties window.

Choose how long you want your computer to be idle before the screen saver
comes on. Choose 1 minute in the Wait option.

Click on OK.

To Change the Number of Colors that the screen uses:
If your computer should give you a message stating that the program you are
trying to run only runs in 256 colors, follow the directions below.

>
>
>

Right click anywhere on the blank desktop.
Click on Properties, then on Settings.
Under Color Palette, select 256 colors and in the desktop area, the setting

should be 640x480 Pixels.

Click on OK.
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Software Helper
Windows 98

Windows 98 is easier to use and more user-friendly. It features icon highlighting,
forward and backward buttons, an auto-complete feature and easy to customize Start
menu.

4 New Toolbars:
> Quick Launch Pad- Allow easier access to your favorite programs
> Address- Enables you to type in a web address from the toolbar
> Links- A selection of one-click connections to commonly used Web sites.
> Desktop- Enables you to put your entire set of desktop icons on the toolbar.

Start a Program using the Quick Launch Pad:
> Click on an icon on the Quick Launch Pad located at the bottom left of the
screen.

Return to the Desktop using the Launch Pad:
> Click on the Desktop icon on the Launch Pad

Add a Program to the Launch Pad:
> Click on Start, Programs and locate the program you wish to add.
> Right-click and drag the icon to the Launch Pad.
> Release and click on Create Shortcut Here.

Change the Length of the Launch Pad:
> Click and drag the line located to the right of the Launch Pad.

Delete an icon from the Quick Launch Pad:
> Right click on the icon and select Delefte.

Address Bar (allows you to type an address from the toolbar):
» Right click on the taskbar, click on toolbars and address.
> Click inside the address box and type in your URL

Links Toolbar:
» Right-click on the taskbar, Toolbars and Links
> Click on a link and your web browser will launch the site.
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Widen the Taskbar:
> Click and drag the top of the taskbar to make additional room for the
toolbars.

Delete a link from the Links Toolbar:
> Right-click on a link and select Delete

Add a link to the Links Toolbar:
> Open your web browser and locate a favorite page.
> Click and drag the location icon to the left of the address onto the beginning
of the links toolbar.

Desktop Toolbar:
> Right-click on the taskbar, click on Toolbars and Desktop

Forward and Back Buttons:
> Click on My Computer and Drive C.
> Click on the Windows Folder and then Show Files.
> Click on the Back and Forward Buttons.
> Click on the drop-down arrow on the Back/Forward button.

Change the Background of a Folder:
> Double-click on a folder.
» Click on View and Customize this folder.
» Choose a background picture and click Next
> Select a background picture, click Next and Finish.

Undo Customization:
> Click on View, and Customize this folder
> Click Remove Customization.

To make a graphic from the web your wallpaper:
> Open your Internet browser.
> Locate the graphic you wish to use and right-click on it.
» Choose Set as Wallpaper.

To return the wallpaper back to its original state:
> Right-click on the desktop and click on Properties.
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>
>

Click on the Background Tab and select the option you wish.
Click OK.

To change the Background Themes:

>

What is
>

Click on Start, Settings, Control Panel and Desktop Themes

the Active Desktop?

One of the improvements in Windows 98 is the Active Desktop, which enables
the Windows desktop to interface with the Web. This feature enables you to
navigate by clicking on links rather than double-clicking icons. You can also use
the Active Desktop as an information center, by placing components from the
Web on your Desktop to display news, weather, sports and other important
information.

How do I turn on the Active Desktop?

>
>
>
>
What is
>

Click on Start, Settings, Folder Options, Web Style, and OK or...

Click on Start, Settings, Active Desktop, View as Web Page

The cursor now fturns into a hand when you move over icons.

The channel bar is an indication that the Active Desktop is furned on.

a Channel?

A "Channel” is a web site that is designed to deliver information from the
Internet to your computer, similar to subscribing to a Web site. A
subscription enables your computer to download updates on a regular basis for
you to view at your convenience, without paying connection charges. You don't
have to subscribe to view the content on a channel, but you may want to set a
schedule for your subscription. Another advantage of channels is that you
don't just see the Web page, you see a map of the Web site that enables you
to quickly select the information you want.

How do Channels Work?

>

>

Use the Channel Guide on your desktop or in your internet browser to see a
list of channels available through the Microsoft Web site. This list is
frequently updated with the latest offerings.

Add channels to your Channel bar. If you wish, you can subscribe to a channel
when you add it to your Channel bar however, you don't have to subscribe to a
channel to view it.

Add channels to your Channel Bar:
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> Click on Channel Bar and Active Desktop items.

> Click on a channel of your choice and Add Active Channel.

> Click NO, just add it to my Channel Bar.

To Delete a Channel:
> Right-click on the channel and click Delete.
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Software Helper
Introducing XP Things You Might Like to Know

Microsoft Office XP software is full of features and options. Although many of the
features have been in the MS Office software for a while there is some new
functionality in this version.

Task Pane

Task Pane is a new feature in Microsoft XP
Software. It puts key commands in a panel on
the right side of the computer screen. It is
specific to the software that you are using so € % MNewDocur ¥ X

the PowerPoint Task Pane is different from
the Word Task Pane although there is some
overlap. One nice thing about Task Pane is

Open a document
PowerPoink 2000- T
PoweerPoink 2000- T
PPT Presentaktion e

Excel Z000- Making
= More documents. .,

that it makes visible some options that people
might not otherwise find, like femplates.

Mes
[ Blank Docurment
@ Blank web Page
=] Blank E-mail Messag

® Left and right arrows in the tan bar at
the top of the Task Pane window let's you

switch to other lists of commands. New from existing
docunment

® The drop down arrow in the tan box at the Il e dahmaE.

top of the task pane let's you see a list of
menus that are available.

Mew from template
] ] General Templates,

% Templates an s W

L5 ] Templates on Micro:

® The X button in the tan box let's you close
the task pane and gives you a larger
screen space.

# To prevent Task Pane from opening when
you start a program, click on the View
menu and remove the check next to Task
Pane. Another option is to remove the
check next to Show at Startup at the
bottom of the New Document Task Pane
window.

[ Add Metwork Place.
@ Microsoft YWiord Help

e |

w| Show ak skartup ‘

Start Button
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In XP the interface under the Start button has been redesigned. Things like My
Computer and My Documents are now available under the Start Button. Control panel
also has been re-organized and given a new look,

Smart Tags

In this latest version of the software, XP attempts to further sense and
respond to what you are doing in a document. If you perform an operation that could be
handled more than one way, a smart tag appears. When you click on the smart tag your
options appear and you can just click on one of them. For instance, if you are pasting
text from one document into another a smart tag will appear. What it wants to know is
if you want to keep the same formatting or match the pasted text to the formatting of
the destination document. Whenever you do something that could be completed in more
than one way you will see a smart tag.

Double Down Arrow

The standard tool bar has drop down menus. When you click on the File menu it drops
down so that you can see what is in it. A change has been made in this version of XP
where they show you the most commonly used items on the menu and then hide the rest.
On the bottom of the list is a double arrow pointing down. Click on it to expand the list
and see everything in the menu.

If you would rather see everything each time click on the Tools menu and then on
Customize. Under the Options tab place a check next to Always show full menus. When
you click OK, that changes your menus. They will now open completely each fime.
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Rainforest Researchers

Teaching
Strategies
Modeled

Technology
Strategies
Modeled

Instruction
Essential Questions for Teachers: How do I use interactive grouping
software? How do I manage the use of simulation software with groups
of students?

Whole Group
Instruction

Rainforest
Researchers

Essential Question:

What is causing the durian fruiting problem? What culturally
influenced activity could be causing the durian problem? How can
teaming with other students help me gain more knowledge?

Learning Standards (State of Michigan):

Social Studies Standards

All students will describe, compare, and explain the locations and
characteristics of places, cultures, and settlements.

All students will describe, compare, and explain the locations and
characteristics of ecosystems, resources, human adaptation,
environmental impact, and the interrelationships among them.

Materials:

Rainforest Researchers Software, and handouts/data collection
sheets. A computer with a scan converter for whole group
learning.

Technology Connections: Students will role-play as members of a
research tfeam. They will use a computer or videotape to explore
the possible causes of the durian problem.

Procedures:
Introduction

1. Set the stage for your students by describing the role-
playing event they will take part in.

2. Organize students into groups of 4 and assign roles.

3. Use Webster.com to help students understand the role
they will play by brining up the definition on the screen
from the Web site. Pass out worksheets.

4. Follow on screen prompts as you guide your students
through the experience.
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Assessment: Students will be assessed on their completion of
the worksheets, calculation of answers, strategy presentation
and group participation.

Individual
Work
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Rain Forest Researchers
Step by Step

Open Rain Forest Researchers.

On the opening screen, choose New. The New Session screen offers you the following

options:

e Choose the number of teams for this session (can be 1 to 8).

e Set the printer option (use printer or don't use printer).

e Choose to watch the Main Intro on the computer or on video.

e Choose the story. We will do "The Case of the Missing Durians."

e Type a name for the session file (8 characters, no spaces or punctuation marks
should be included in the file name.

When all your session options are seft, click Go Ahead.

To play the Main Intro, click on Play fo start the video. After the Main Intro read the
Case Background in expert books and learn about jobs. Team members should then share
information and answers for the Pro Tropics Expert Quiz.

Team members need to work fogether to answer the questions. Each book provides one
of the answers.

After reading pages 4-5, the team writes the answers to the Expert Quiz on their field

worksheets.

e Select a team name.

e Select a team captain.

e Team will approach the computer to sign in with the Pro Topics. (The screen they
see on the computer is the Turn Manager---the place to sign in for Turn 1.)

e Click on the "Click to Sign In" button to begin the Sign In turn.

e The Random Expert Picker appears before the turn progresses.

The Random Expert Picker is a means of selecting a leader for each turn.
e The Turn Leader will enter the team's choices at the computer, via the keyboard or

the mouse.

Sign in.
e The Turn Leader should type in the name of the team and the names of each expert.
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e When the Turn Leader enters the responses to the Expert Quiz, students should
remember that spelling is IMPORTANT!
e Anincorrectly spelled response will be evaluated as wrong.

Teams work with a budget of $40,000. They can't actually run out of money, but the
program does offer each team a rating depending on the amount of money remaining in
the budget when they finish. Teams are charged for incorrect quiz responses, random
supply events, and major team decisions.

Team watches the Case Intro, a short video that sets up the problem faced by the
team.

e Click on Play to start the video.

e Teams may watch the video as many ftimes as desired.

e After entering all decisions and watching the video, click on End Turn.

e Instructions are given to the team at this time - Read pages 6-7.

All teams will repeat the above steps for their turn at the computer.

The Teams now PREPARE FOR THE TRIP!

e After reading pages 6-7, select seven supplies and record them on the field
worksheets.

e When ready, go to the computer to choose supplies.

Turn Manager now offers a button for each feam that signed in.

e Click feam buttons to begin turn. (After a feam has taken its turn a check mark will
appear on the screen by the team's name.)

e Click seven supplies for the frip.

e  When the team clicks Buy Supplies, they are committing to their seven choices.

e All teams should submit their supply list.

After seeing a budget report about their supply expenses, the teams now watch the
Trip

Video.

e This video sets up the problem facing the teams in greater detail and tells the teams
that the answer has been narrowed down to four choices.

e The teams must decide what is causing the durian fruiting problem.

e Now each expert must recommend an expert test to the team.

e After reading pages 8-10 and agreeing on four expert tests, the teams can visit the
computer to enter test choices and get results.
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e There are no strictly right or wrong expert tests. Each test will provide the team
with a piece of information.

The first thing encountered by the teams on this turn (after the Random Expert Picker)

is a Supply Event.

e Supply Events are random occurrences that happen on Turns 3, 4, and 6.

e These events are based on the reality of conducting scientific research in remote
places, and they're a fun and unpredictable element!

e The program randomly selects an event, and then checks the team's supply list o see
if the feam has the right item to overcome the problem.

e If the team doesn't have the supply, they are charged to overcome the problem.
(The amount of money assessed is twice the cost of the supply.)

The Turn Leader now clicks one test recommended by each expert.

e The team commits to its test choices by clicking Do Tests.

e A short video plays regardless of the test choices. The test results will, of course,
vary according to the test chosen.

e The test results appear on the screen after the Tests Video.

e If you have selected the Printer option for this session, the teams can use the Print
button to get a copy of these results.

e If you have no printer, the teams should record the test results on their field
worksheets.

e Each expert should write down the results for his or her test.

It is now time for the teams to analyze the information at their desks using additional

information in their expert books.

e The experts will share information about the possible answer.

* No one expert can realize the answer from his/her results. The team must work
together to come up with the best analysis.

e Teams must rank their answers according to three categories: Definitely, Maybe, or
No Way.

e They send their answers o Pro Tropics, which will thoroughly analyze their answers,
starting with those they ranked in the Definitely category. Pro Tropics will stop only
when the correct answer is confirmed. Each analysis by Pro Tropics cost $5,000..

When the teams have ranked all the answers, they visit the computer briefly to enter

their choices.

e The teams get a response from Pro Tropics only when the last team has sent its
answer.

e When the Pro Tropics response screen appears, all the teams should gather around
the computer to watch the outcome at the same time.
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e Read pages 12-13 after receiving a response from Pro Tropics. These pages have
information that is common to all expert books and information that is unique.

Teams should now spend time reading and sharing information about similar situations.

e Each team selects two surveys (from the available four) that will provide information
to help them make their final decision. There are no right or wrong survey choices.
All the information is helpful in some way.

e Teams visit the computer to choose surveys. The field worksheet has an area for
students to record their results.

e Encourage the teams to replay the survey videos several times.

e Teams should read pages 14-15.

Now the teams are faced with the final decision.

e They must determine what caused the change in the ecosystem.

e The teams discuss the four possibilities and agree on a team choice.

e This decision does not require ranking: instead each team must agree on a single
answer, which Pro Tropics evaluates.

e If Pro Tropics agrees with a team's answer, no money is assessed against the team's
budget.

e If Pro Tropics disagrees, the budget will be changed.

When all teams have decided on their answers on paper, they each visit the computer
briefly to enter their choices.

e Pro Tropics will give feams a response only when the last team has sent in its answer.
e All feams should gather around the computer to watch the outcome.

After the Pro Tropics response, the last step is to sign out at the computer and receive
the final team rating.

e When the teams sign out, they see a report of where they stand, budget-wise, and a
researcher rating. The ratings are Emergent Layer, Canopy, Midstory, and
Understory.
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Rain Forest Researchers

Directions: Earn points foward saving the Rain Forest by answering the following
questions.

Taxonomist:

1. If nothing is done to save the rain forest, we may witness the highest rates of
species extinction since the age of the

2. The durian fruit is known throughout Southeast Asia for its

3. Where are most durians grown?

4, involves the collection, identification, and study of
organisms.

5. How many species of ants live in the world?

6. A typical ant is only the size of a human being.

7. Inrain forests, the weight of all the put together is
greater than the weight of any other family of animals.

8. Wasps and ants evolved from a common

9. The islands of Indonesia form a chain longer than the distance from Los Angeles to

10. Fish, amphibians, reptiles, birds, and mammals make up only % of all
known species.
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Rain Forest Researchers

Ethnobotanist:

1. If nothing is done to save the rain forest, we may witness the highest rates of
species extinction since the age of the

2. The durian fruit is known throughout Southeast Asia for its

3. Where are most durians grown?

4. People in Papua New Guinea grind up the roots of ferns to make

5. What is used in cooking when salt is unavailable?

6. What is used to adorn the deceased during funerals?

7. How long is the rainy season in Java?

8. What surrounds the planet like a belt?

9. What are the two seasons in the world's tropical regions?
1.
2.

10. Plants make up % of all known species.
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Rain Forest Researchers
Ecologist:

1. If nothing is done to save the rain forests, we may witness the highest rates of
species extinction since the age of the

2. The durian fruit is known throughout Southeast Asia for its

3. Where are most durians grown?
4, Millions of years ago, the western half of Indonesia was actually connected to
5. Where is Indonesia located?
6.  List Indonesia's five major islands.
1.
2.
3.
4,
5.
7. How long is the rainy season in Java?
8. Where do the world's tropical regions occur?

9. Where is the greatest biodiversity on Earth found?

10.  Even though scientists have identified 1.5 million species on this planet, there may
be species still waiting to be discovered.
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Rain Forest Researchers

Chemiist:

1. If nothing is done to save the rain forest, we may witness the highest rates of
species extinction since the age of the

2. The durian fruit is known throughout Southeast Asia for its

3. Where are most durians grown?

4, Some plants use a chemical to announce
their presence.

5. One species of in Costa Rica
seeks a habitat inside a certain species of flower.

6. How do mites search for the right flower to habitat?

7. What plant of Southeast Asia puts a whiff of chemicals in the air that smells like
rotting meat?

8. How long does the Rafflesia trap its food?

9. How long does the Rafflesia hold its insects captive?

10. List three invertebrates:
1.
2.

Copyright © 2004 i3 Training Services Inc. inspiring, innovative, integration Day 1



Technology Tools in the Secondary Social Studies & Language Arts Classroom Trainers Manual

Rainforest Researchers - Day 1 - page 52

NOTES

This is a supplemental lesson plan that can be used if time and software is available.

Copyright © 2004 i3 Training Services Inc.



Technology Tools in the Secondary Social Studies & Language Arts Classroom

52

Budget $40,000

Expenditures

Cost

Balance

Beginning Supplies
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Daily Closure

Trainer Notes -
e Recap the day.
o Take questions that participants have.
e Assigh Homework
e Have participants straighten up their area.
e Shut down computers
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Web Harvest Sheet

Use this sheet to record URLs that you want to
remember for later use.

URL Title Description
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